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Chapter 1 

Getting Started 
This document provides a demonstration of the Applied 
Microsystems SuperTAP system integration tool with 
MWX-ICE debugger. It assumes the SuperTAP and debugger 
are installed and the debugger is connected to the emulator, 
described in the Emulator Installation Guide and Chapter 2 of 
the MWX-ICE User's Manual. 

Applied Microsystems Corporation 

Getting Started 

Founded in 1979, Applied Microsystems is a leading ISO 9002-
certified provider of integrated development systems for 
embedded microprocessor design. The company helps 
engineers develop and test quality products faster, more 
reliably, and at a lower cost through a growing family of 
compatible design tools. 

Why choose Applied Microsystems for my Motorola project? 
Applied Microsystems is an experienced and innovative leader 
in the field of microprocessor development tools. Motorola 
realized this when they made Applied Microsystems a 
preferred Motorola "Platinum" development tools partner. 

Applied Microsystems has a long and successful record 
supporting Motorola microprocessors; from the 6809 to 
PowerPC. Over 17 years experience with Motorola 
microprocessors lets us provide tools with the critical features 
necessary to debug today's complex software applications in 
high performance embedded systems. 

First and fastest, Applied gave the industry its first 33 Mhz 
68020/030 emulator, its first 40 MHz 68040 emulator, and its 
first 66 MHz 68060 emulator. 



Customer support 

Committed to your success 
Good support is as critical a part of your development system 
as the emulator or the debugger. Applied Microsystems 
Customer Support department employs a large staff of 
engineers and offers a full range of timely and effective support 
services. 

Contacting Customer Support 
PHONE: If you encounter trouble while evaluating this 
product, call Customer Support at 1-800-ASK-4AMC (1-800-
275-4262). 

FAX: To FAX Applied Microsystems, dial 1-206-883-3049. 

EMAIL: If you have access to the internet, you can contact 
Applied Microsystems by sending email to support@amc.com. 

WWW: Applied Microsystems maintains a World Wide Web 
site located at URL http://www.amc.com. 

Demonstration overview 
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Chapter 1 of this guide introduces you to the SuperTAP and 
MWX-ICE debugger. After a product description, you start the 
debugger and become familiar with using its windowing 
system, load the demonstration program, and display 
SuperTAP configuration information. You must complete all of 
Chapter 1 before doing any of the examples in Chapter 2. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Running the examples 
Chapter 2 contains examples demonstrating basic debugger 
operation and key debugging features of Applied Microsystems 
SuperTAP. The examples are organized into functional groups, 
with each group prefaced by a brief discussion of the function. 

How long does it take? 
It takes approximately two hours to complete all the examples. 
However, the examples are not interdependent; you can choose 
to run, in any sequence, the examples that most interest you. 

You must complete each step within an example. The final 
steps of an example return settings to their original value, so 
you can do the examples in any order. 

Running in other targets 

Demonstration overview 

The Cdemon demonstration code used in this guide was 
written for the Applied Microsystems demonstration board. 
Cdemon is loaded into emulator memory which has been 
configured (mapped) to replace (overlay) the desired address 
spaces of target memory. Because the program runs in overlay 
memory, the demonstration can be run without a target, with 
the emulator in isolation mode. 

Although the program runs in overlay memory, all write cycles 
still go out to the target. The demonstration can be run in other 
embedded targets if the following memory considerations pose 
no problem: 

address range type of memory 
OxOOOOOO - OxOlffffread/write 
OxlOOOOO - Ox17ffffread/write 
OxleOOOO - Oxlfffffread/write 

3 



Evaluation Guide conventions 

Ylarnin~ 

Caution& 
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Throughout the guide, an arrow in the margin indicates the 
beginning of procedures that you should follow. Below is an 
example of this type of procedure. (Do not follow the procedure 
at this time). 

>- To restart the Cdemon program: 

• In the Command window Enter Command box, enter: 
restart 

The frog in the margin indicates that a feature is unique to 
Applied Microsystems products, and provides considerable 
benefit to you in debugging. 

Warning messages appear before procedures and alert you to the 
danger of personal injury which may result unless certain 
precautions are observed. 

Caution messages appear before procedures and indicate that 
damage may be done to the emulator or to your target system 
unless certain steps are observed. 

Notes indicate important information for the proper operation 
and installation of your emulator. 

Need help? Call Customer Support at 1·800·ASK·4AMC for assistance. 



Radio interference warning 

Caution& 

Radio interference warning 

This equipment generates, uses, and can radiate radio 
frequency energy. 

This instrument is intended for use in the development of 
microprocessor-based systems. At this stage of development, 
these target devices typically include no inherent design to 
limit the emissions of electromagnetic energy. 

Precautions should be taken to prevent harmful radiation to 
radio communications and other nearby sensitive electronic 
systems by means of isolation, separation, or shielding, where 
necessary. 

Use of this instrument in a residential area is likely to cause 
harmful interference, in which case, the user will be required 
to correct the interference at his own expense. 

FCC Rules 
It is temporarily permitted by regulation and has not been 
tested for compliance with the limits of Class A computing 
devices pursuant to Subpart J of Part 15 of FCC Rules, which 
are designed to provide reasonable protection against such 
interference. 

EMC Directive 
For compliance to the essential requirements of the EMC 
Directive 89/336/EEC, if a ground post is provided on the back 
of the chassis or on the external power supply, a properly 
bonded ground strap must be connected to it. 

5 



Operating requirements 
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Before setting up the SuperTAP, you should make sure that the 
operating environment is prepared. 

CE-compliant systems: The AC third wire ground (safety 
ground) is not connected to the emulator's digital ground. For 
proper operation, your target's safety ground and digital 
ground should not be connected. If they are connected, 
operation will result in the emulator's DC voltage fuses (if any) 
blowing. If the target power supply's digital ground cannot be 
isolated from the safety ground, then temporarily connect a 
wire between the ground stud on the emulator external power 
supply and target digital ground. This ground wire is in 
addition to the ground wire between the power supply ground 
stud and AC ground that is required for CE compliance and is 
described later in this manual. 
Under no circumstances should the third wire prong on the 
emulator power cord be removed or disconnected. 

Non-CE-compliant systems: The AC third wire ground 
(safety ground) is connected to the emulator's digital ground. 
For proper operation, your target's safety ground and digital 
ground should also be connected. If they are not connected, the 
DC voltage fuses (if any) in the target or in the target power 
supply may blow. For correct operation, connect your target's 
safety ground and digital ground. 
Under no circumstances should the third wire prong on the 
emulator power cord be removed or disconnected. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Be sure the emulator and target are plugged into outlets that 
have good electrical continuity on the third wire safety ground. 
If there is high electrical resistance on the safety grounds of 
either or both the target power supply and emulator power 
supply, unwanted ground current may be drawn through the 
emulator probe, damaging the emulator or target system. 
Good electrical continuity is also required to maintain the 
EN55022 Class B Conducted Radiation Specification of the 
emulator power supply. 

Standard electrostatic precautions 

Operating requirements 

This instrument contains static-sensitive components that are 
subject to damage from electrostatic discharge. Use standard 
ESD precautions when transporting, handling, or using the 
instrument and the target, when connecting/disconnecting the 
instrument and the target, and when removing the cover of the 
instrument. 

Applied Microsystems recommends the use of the following 
precautions: 

a Use wrist straps or heel bands with a 1 Megohm resistor 
connected to ground. 

a On the work surface and floor, use static conductive mats 
with a 1 Megohm resistor connected to ground. 

a Keep high static-producing items, such as non-ESD­
approved plastics, tape and packaging foam, away from the 
instrument and the target. 

The above precautions should be considered as minimum 
requirements for a static-controlled environment. 

7 
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The emulator contains components that are subject to damage 
from electrostatic discharge. Whenever you are using, 
handling, or transporting the emulator, or connecting to or 
disconnecting from a target system, always use proper anti­
static protection measures, including static-free bench pads 
and grounded wrist straps. 

Need help? CaU Customer Support at 1-800-ASK-4AMC for assistance. 



Product overview 

Product overview 

The SuperTAP is a complete tool for system debugging and 
integration. You can use SuperTAP and MWX-ICE in full in­
circuit emulation mode to bring up your target hardware, 
program flash memory, or execute code before target hardware 
is available. The SuperTAP supports external bus masters in 
multi-processor target systems. You can also use the SuperTAP 
and MWX-ICE in DPI-only mode to debug rack-mounted 
hardware or for field troubleshooting. 

The SuperTAP system integration tool is one member of 
Applied's Design, Test, and Debug tool-set for MPC860 
developers. Other members of this family include: 

a CodeTEST™ software testing and verification tools let you 
optimize your software's performance and ensure quality 
and reliability in your finished product. 

a NetROM™ universal target communications tool transforms 
your target into an easily accessible network node and 
provides a high-speed Ethernet connection between target 
and host. 

a VSP-TAP™ lets you execute real product software against a 
model of your ASIC and to stimulate the ASIC design with 
real-world data. VSP-TAP works in concert with View logic's 
modeling and simulation tools. 

a CodeTAP® application development and debug tool 
combines full processor and target visibility with integrated 
support for for multiple debuggers including MWX-ICE and 
Wind River's Cross-wind. 

Contact Applied Microsystems for detailed information about 
these tools. 

9 
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Emulator, BDM, and logic analyzer in one tool 
SuperTAP provides a high-quality yet cost-effective approach 
to developing and debugging Motorola MPC860 family 
embedded processor systems. Highly versatile, SuperTAP is an 
emulator, BDM, and logic analyzer in one tool. 

SuperTAP physically replaces the target system's embedded 
processor, then communicates through an Ethernet or high­
speed serial link to MWX-ICE CIC++ source-level debugger. 

Uses no target resources 
Unlike ROM monitors, SuperTAP uses no target resources like 
110, memory, or serial ports. Unlike other emulators, 
SuperTAP does not install a monitor in target memory or make 
use of any target resources. SuperTAP does not even require a 
fully functional target, as is common with prototype hardware. 

Non-stop emulation (NSE) 
NSETM lets the target system continue to run even when you 
are defining events or uploading trace. This is made possible by 
the SuperTAP's dual-processor architecture. NSE can be 
particularly useful for targets that need to service interrupts 
on demand. 

Debug and track execution of cachH&sed code 
A large part of the impressive performance o.f the MPC860 
comes from its two large code and data caches. If you turn them 
off to debug the software your product may no longer function. 
You need to debug in an environment that closely matches the 
way the real product will operate. 

SuperTAP solves the problem with its technology for tracking 
code executed in cache. Now you can debug with the caches 
enabled to enjoy a more realistic target debug environment. 

Isolate complex software and hardware bugs 
Most software bugs are caused by data corruption (stack and 
data pointers becoming corrupt) and program misdirection 
(jumping to the wrong address). Or, the software may run 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Product overview 

correctly but the target hardware does not respond as it should. 
SuperTAP addresses these problems quickly and efficiently, 
providing: 

a Real-time emulation with an easy to use multi-windowed Cl 
C++ source-level debugger supporting the popular PowerPC 
compilers 

a A multi-thread event system which allows tracking and 
detecting the state of the program as well as the processor 

a 64K by 128 bits of bus cycle trace history monitors 160 
signals and provides raw bus cycle, assembly, and CIC++ 
source-level display modes 

a 1, 4, or 8MB of overlay memory to hard code, replace, or 
extend target memory 

a Data access breakpoints in RAM or ROM 
a Execution breakpoints in RAM or ROM 
a Trigger input/output capability for linking together multiple 

instruments 

Configure complex integrated peripherals 
Configuring the MPC860 peripherals can be a real challenge. 
The processor data book holds 23 chapters and over 1300 
pages. SuperTAP's MWX-ICE CPU Browser simplifies 
developing and debugging device drivers by providing: 

a A description of the function of each bit of each register 
a Pulldown menus with the possible status for each bit 
a The resulting hexadecimal register value for a particular 

configuration 

Accelerate your firmware development 
In isolation mode, SuperTAP can be operated stand-alone with 
out a being plugged into a target. With your code loaded into 
overlay memory, isolation mode lets you begin debugging your 
program before target hardware is available. 

11 
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Troubleshoot prototype hardware 
You can verify the design of your hardware and quickly isolate 
manufacturing defects using built-in diagnostic test routines 
and scope loops provided by SuperTAP. Combined with an 
oscilloscope, SuperTAP can quickly isolate manufactoring 
errors in target hardware. 

Monitor target conditions 
SuperTAP monitors and reports target conditions such as: 

Cl Processor clock frequency 
CJ Target V cc 
CJ Bus error 
CJ Reset asserted 

Real·time visibility into your RTOS·based system 
SuperTAPhelps you debug both before and after your kernel is 
working on your target. Applied's RTOS-Link option provides 
several broad categories of support, including: 

Cl Real-time insight to help develop your Board Support 
Package (BSP) 

CJ A real-time tool that let's you debug your kernel 
initialization code 

CJ Real-time trace of RTOS activity 
CJ Display of individual task context and other system 

structures 
CJ Task-qualified breakpoints and stack overflow detection 
CJ Task profiling support 
CJ System-level OS support to debug your Interrupt Service 

Routines 

The benefit of integrated RTOS support is a substantial 
reduction in the time required to debug and optimize your 
application as it runs in your target. 

The event system is specifically designed to help isolate 
problems in multi-threaded software systems found in kernel 
applications. The system is organized in a four-state-by-four-

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Product overview 

group structure. Each group can be applied to a software 
thread and the four states can be used to isolate deeply nested 
bugs. 

Stop-in-target mode permits a single target execution thread to 
be halted while maintaining additional program threads in 
target. You can determine how frequently the emulator 
interrupts the target operation and the maxim.um time it can 
spend out of target before restoring the un-halted threads. The 
emulator can interrupt the current operations, service its 
interrupts, restore the original bus state, and resume the 
original operations. 

Compatibility with your tools and hosts 
Host support includes: 

CJ Sun 4 (Sun OS 4.1 and above) 
CJ PC (Windows 95 or WinNT) 
CJ HP9000 (HPUX 9.0) 

Compiler support for all CIC++ compilers generating ELF/ 
DWARF version 1.03 or ELF/stabs including: 

CJ GNU (CIC++) 
CJ DIAB data (CIC++) 
CJ Greenhills (C) 
CJ MRI (C) 
CJ Metaware (CIC++) 

SuperTAP used with Applied's RTOS-Link provides support for 
WindRiver and ISi real-time kernels. 

Non-intrusive performance analysis 
SuperTAPs timestamp capability greatly aids in viewing 
system activity and finding code bottlenecks. 

For the most powerful software measurements, team 
SuperTAP with Applied's CodeTEST software verification and 
test tools. CodeTEST provides detailed Performance Analysis, 
Code Coverage Analysis, Memory Allocation Analysis, and 

13 
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extended Source Trace Analysis. For details, request a 
CodeTEST specification sheet or view the information on 
Applied's web site (http://www.amc.com). 

Innovative target connection support 
The MPC860 adapter and connector support includes: 

o BGA to PGA connector 
o Logic Analyzer adapter 
o Mirror adapter (leaves the processor on card) 
o Rotation adapters (to facilitate target connection) 
o Motorola ADS 8XX header adapters (leaves ZIF socket on 

card) 

Electrical characteristics mimic the CPU 
With its fully isolated probe-tip, the SuperTAP behaves 
electrically as close to the emulated microprocessor as is 
possible with today's technology. Zero-delay buffering ensures 
the most accurate emulation. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



MWX·ICE Debugger for SuperTAP 

Debugger features 

MWX-ICE Debugger for Super TAP 

MWX-ICE is a function rich, Sun 4, HP 9000/700, or PC-hosted, 
CIC++ source and assembly-level debugger, developed solely 
for debugging embedded applications. MWX-ICE's multiple 
windows, pull-down and pop-up menus, and point-and-click 
ease of use provide a fast, interactive debugging environment. 

MWX-ICE gives you complete control over SuperTAP 
functions: you can selectively start and stop execution, view 
program execution trace with source disassembly, and display 
and modify CPU registers and memory. 

MWX-ICE features include: 

a Point-and-click encapsulation of the debugger language via 
command buttons and "notebooks" 

a Diab data, GNU, Greenhills, and Metaware compiler 
support 

a Full support of SuperTAP hardware including Trace, Event, 
and Overlay 

a Powerful breakpoint conditions/actions 
a C, C++, assembler expression evaluation 
a Versatile and complete macro language 
a Accepts batch mode command files 

Easy to use interface 
The MWX-ICE debugger is a "windowed" user interface. 
Commands are usually executed either of two ways: by typing 
the command in a Command window, or by clicking a button 
that activates the command. Also available for command 
execution and data entry are editable debugger Windows and 
Notebooks accessed through pull-down menus. 

15 
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Shortens the learning curve 
Users may find the more intuitive buttons easier to use while 
learning the debugger. If a button has a command line 
associated with it, that line will be printed in the Command 
window when the button is clicked. This shortens the learning 
curve for users who may ultimately prefer the speed of the 
command line by providing learning reinforcement with each 
button click. 

Powerful Help system 
MWX-ICE includes an extensive but easy-to-use hypertext 
Help system that saves you time otherwise spent searching 
through manuals. 

Handles symbols in a variety of ways 
Symbols include arrays, structures, static variables, register­
based, and stack-based variables. Symbols can be displayed or 
changed by name, as declared in your program. You can display 
the type and scope of each symbol, and its value in binary, hex, 
ASCII, or decimal format. You can also display memory 
contents with absolute references or register-relative 
references using the Memory window. 

Data and Inspector windows 
MWX-ICE Data and Inspector windows provide access to high­
level data structures and dynamic variables, and includes C++ 
object support. You can reference structure members, 
dereference pointers, and apply type overrides. 

The Data window lets you easily monitor and examine data 
(and code) using C and C++ source constructs for a dynamic, 
real-time view of the data structure. 

The Inspector window lets you view complex high-level data 
structures and quickly traverse linked lists. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



MWX-ICE Debugger for Super TAP 

Powerful macro support 
Easily set up using an MWX-ICE "notebook", macros allow full 
access to debugger features, source-code, and prograni. 
variables. By using the "button editor" you can attach macros 
to the MWX-ICE user interface. 

Macros can be tied to break.points, providing an excellent 
method to patch source-code on the fly, and to create program 
"stubs" for code not yet developed. 

Evaluates C, C++, assembler expressions 
An expression is a combination of operators and operands. 
MWX-ICE supports C, C++, and Assembler expressions. 

MWX-ICE supports the complete C expression syntax. You can 
call your C functions, with arguments, from a C expression; 
exactly as you do in your code. This can be useful for testing the 
behavior of any newly created functions. 

17 



Using SuperTAP with MWX-ICE 

Configuring the initregs 

Note ~ 
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The SuperTAP maintains a copy of the values stored in some of 
the processor's chip-select and pin assignment registers. This 
copy is called the set of initialization registers, or initregs, 
because it is used whenever you resume operation after a 
target-generated or MWX-ICE command-driven processor 
reset. The initregs must match the values that the processor 
chip-select and pin-assignment registers have after you run 
your initialization code. When you save or restore the initregs 
without specifying a path and filename, MWX-ICE uses the file 
named iregs.xxx.dat (where the .xxx is replaced by your 
processor type: 860, 821, and so forth). 

MWX-ICE is shipped with four pre-defined versions of the 
iregs.xxx.dat file located in your 
install_directory \amc \ ST8XX: 

IJ iregs.xxx.dat.def - (default) used with isolation mode or as 
a template to be customized for a specific target 

1J iregs860.dat.amc - used with the Applied Microsystems 
demonstration board 

IJ iregs860.dat.ads - used with the Motorola ADS board 

IJ iregs860.dat.all - useful for capturing the values of all the 
configuration registers 

The system default iregsxxx.dat.def file is located in 
install_directory \amc \ STSXX. The original .def file should 
never be modified. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



> To use the iregsxxx.dat.def file for isomode (no target): 

• Copy the file: 
install_directory \ amc \ ST8XX \ iregsxxx.dat.def to your 
working directory as iregsxxx.dat. 

> To use the iregs860.dat.amc file for Applied's 
demonstration board: 

• Copy the file: 
install_directory \ amc \ ST8XX \ iregs860.dat.amc to your 
working directory as iregs860.dat. 

Starting the MWX-ICE debugger 
The Evaluation Guide assumes the SuperTAP and debugger 
are installed and the debugger has been connected to the 
emulator, described in Chapter 2 of the MWX-ICE User's 
Manual. 

> To start MWX-ICE: 

Using SuperTAP with MWX-ICE 

• From Program Manager, choose the MWX-ICE 860 icon. 

MWX-ICE debugger starts with the Code and Command 
windows open, shown in Figure 1. 

19 
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> iii EtlD OF SECTIOH 

Figure 1 MWX-ICE successfully started 

Getting debugger help 
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Context-sensitive Help is available for MWX-ICE. For 
information about Applied Microsystems and Applied 
Microsystems products, choose About MWX-ICE from the Help 
menu, or click the About Applied Microsystems button on a 
notebook page. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Stopping emulation (leaving run mode) 

Stop button 

Important information about leaving run mode 
The SuperTAP emulator operates in one of two modes: run 
mode, when the emulator is executing target code, and pause 
mode, when the emulator is not executing target code. In run 
mode the cursor turns into a "running man." To leave run mode 
at any time and return to pause mode, click the Stop button in 
the tool bar. 

Loading the demonstration code 

Using SuperTAP with MWX-ICE 

Cdemon is the Applied Microsystems standard CIC++ 
demonstration program, providing examples of many code and 
data constructions used by programmers. The demonstration 
program is designed to be used with the SuperTAP and an 
Applied Microsystems demonstrator board. 

Cdemon is composed of four major functions running in main(): 
initial(), step(), data(), and run(). The LEDs on the 
demonstrator board or a Data window monitoring led_port can 
be used to see the output of some of the functions. For a 
detailed explanation of the Cdemon demonstration program, 
see Appendix A of this guide. 

"Include" debugger command files 
An include file is simply a file containing debugger commands 
that will be executed when the file is loaded by the debugger. 
The supplied include file, cdemon.inc, maps overlay then loads 
the Cdemon absolute file from the demo subdirectory. 
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>- To load the demonstration file: 

1. From the Displays menu, choose Code. 

2. From the File menu, choose Include Commands. 

3. Using the file browser, navigate to the 
install_dir \amc \STSXX\demo directory. 

4. Select cdemon.inc, then choose OK 

Observe the Command window for SuperTAP status and ex­
ecuted commands. After downloading the file, the Code win­
dow displays the source module, shown in Figure 2 . 

• Code l!lr!J £Ji 

Figure 2 Cdemon demonstration file successfully loaded 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Viewing source-level and assembly code simultaneously 
The Windows menu "Copy This Window" button lets you open 
multiple instances of a window. Below, you open two Code 
windows; one window displaying source-level and the other 
displaying interleaved source-level and assembly. The two 
windows stay synchronized during all emulator operations 
such as single-stepping, running to breakpoints, and restarting 
the code. 

To open another Code window and display assembly: 

1. Make the Code window active. 

2. From Displays menu, choose Copy This Window. 

3. In Mode button for the new Code window, choose Assembly. 

You can arrange the two Code windows for the best viewing, 
shown stacked in Figure 3. 

'M\o/XST860[1omb2J_c_o-de ____ -------------------- -9l3tJ 
j Co...,nd Hl'C861 Module: CDEHOH File: cde11111n .cc i• 

1---------·ir·~~i;'.:;:~·:::'.:-:'.:·:··--------------------i·;--p-~~-9~;;·-st·~-~-t~---"·;~~---;j·-------------~ 
~ 61 eleu_llliinO; 
j 61 
j 62 initial(); /•Initialize Uariables •/ 
i 63 step(): /• Single Step Loop •/ 
i 61J data(); /•Data Manipulation Demo, Card Gall!!•/ 
~ 65 run(); t• Run Blinking Leds •/ v• 

~ 66 return I; !• 
~-·- -- •«t&:"~~$$~,jfilW}~)ji%J'JJ"•· 
f!i~r860lt::b2J:' ead:'-mm,_,, __ mmmmmmuu-umm''"'"'-~"""'"""=r:::Jai@ 

i co...,nd HPC861 Module: CDEHOH File: cde11111n.cc ~ 
1 56 111ain(int, char •[]) /• Progra111 Starts Here •I 
j 57 { 
~ a.;i:o: 
l fffl2D98: 91121fff8 
1 FFFl2D9c: 7cD8U2a6 
! fffl211al: 9181 lllDc 
' 58 

stw 
lllfspr 
stw 

r1, -llxDDD8(r1) 
rl,lr 
rl,lbclllc(r1) 

1 59 if ( which de11111 ) j
1
_ fffl211alJ: B18dBl11 - l•z r12,-llx7ffl(r13) 
· FFfl211aB: 2cnc1111 c11111wi r12, llXD 
i fffl2Dac: 111821188 beq .+llXB 

h· ··· m.~tmi~~:~r~~:*~W-.M-~~¥1~;w~•~~-~ 

Figure 3 Displaying source-level and assembly code 
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When starting a debug session you should take a quick look at 
the state of the debugger and emulator. This is particularly 
true if someone else has used the emulator between your 
sessions. You can easily examine or modify the emulator's state 
by using the Emulator Configuration window. 

If you ever need to call Customer Support for assistance, the 
information displayed with the following commands and 
windows can help them resolve your call. 

>- To display operating environment information: 

1. In the Enter Command box of the Command window, enter: 

stat all 

This lists details about the current operating environment. 

2. From the File menu of the View status window, choose Close 
Window, being careful not to inadvertently select Exit 
Debugger. 

>- To display emulator component and revision 
information: 

• In the Enter Command box of the Command window, enter: 
hwconfig 

This lists emulator component, firmware, and software revi­
sion levels and installed options. 

>- To view the emulator configuration 

• From the Displays menu, choose Emulator Configuration. 

The Emulator Configuration window appears. 

You can use the Emulator Configuration window, shown in 
Figure 4, to view and modify the options that control the 
state of the debugger and emulator: 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Using SuperTAP with MWX-ICE 

,,... ...... ,.,,,.,,. ........ .-..-...-.. -.. ...-~ .... ----------
! Trace 
r------Ex;-~;i1.;;;--------------------

Me111ory Read/Write r .............. M ...................................................... . 
~ e111ory 
r··········································---------·-· .... -........... . 
! Euent 
............................................................................ 
l File Handling 
.......................................................................... 
I Debugger Options 

Figure 4 Emulator Configuration window 

Connections The Connections button brings up the 
Connections window. Use this window to define and connect to 
emulators. 

Execution The Execution button opens the Execution 
configuration dialog box. Use this dialog box to set the 
emulator execution options. 

Trace The Trace button opens the Trace configuration dialog 
box. Use this dialog box to set emulator trace collection and 
display options. 

Memory The Memory button opens the Memory 
configuration dialog box. Use this dialog box to set memory 
access attributes. 

Event The Event button opens the Event configuration 
dialog box. Use this dialog box to set the emulator event system 
options. 
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File Handling The File Handling button opens the File 
Handling configuration dialog box. Use this dialog box to 
specify the upload and download format for non-IEEE-695 
object files, and to other download options. 

Debugger Internal The Debugger Internal button opens 
the Debugger Internal configuration dialog box. Use this dialog 
box to set input and output radix and other debugger options. 

Need help? Call Customer Support at 1·800-ASK-4AMC for assistance. 



I Chapter2 

Examples 
This chapter provides examples demonstrating the Applied 
Microsystems SuperTAP system integration tool with 
MWX-ICE debugger. You must complete all of Chapter 1 before 
doing any of the examples. 

The examples are organized into functional groups, with each 
group prefaced by a brief discussion of the function: 

Cl Accelerate the debug of prototype hardware 
Cl Accelerate firmware development using overlay 
Cl Intuitive breakpoints on code and data 
Cl Controlling code execution - break.points and event system 
CJ Capturing and viewing trace history 
Cl Examples of other time-saving features 

Running the examples 

Examples 

How long does it take? 
It takes approximately two hours to complete all the examples. 

Run the examples that most interest you 
All the examples can be run independent of each other. 
Because the examples are not interdependent, you can choose 
and run, in any order, the examples that most interest you. 

Complete all steps within an example 
You must complete each step within an example. The final 
steps of an example return settings to their original value, so 
you can do the examples in any order. 
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Crash proof debugging and testing 
SuperTAPincorporates a dual-processor architecture where an 
emulation processor replaces the target processor while a 
second control processor handles communications with the 
debugger and monitors the target processor activity. This 
insures that a target processor crash will not cause the 
emulator to "hang". 

Built-in scope loops and memory diagnostics 
A full suite of scope loops and memory diagnostic programs 
included with the debugger let you verify the design of your 
hardware and quickly isolate manufacturing defects. 

Some companies use the diagnostic routines as part of their 
regression tests.The tests can be left running overnight to 
locate thermal problems. Also, the tests can run concurrent 
with the trace and event systems, useful for locating subtle 
bugs. 

Monitor target conditions 
SuperTAP monitors and reports target conditions such as: 

a Processor clock frequency 
a TargetVcc 
a Bus error 
a Reset asserted 

Target monitoring features can isolate conditions that cause 
other emulators to hang. This ability helps in situations where 
you are debugging new and unproven hardware. 

In addition, the power monitoring circuitry provides electrical 
protection to the target and emulator, lessening the potential 
for damage and reducing the risk of repairs and lost debugging 
time. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 1 - Crash-proof tool including trace history 
Target system and processor initialization routines are often 
the most difficult code to debug, particularly on prototype 
targets. SuperTAP lets you execute to a breakpoint set in a 
target power-up or reset sequence, while collecting trace 
history, without hanging the debugger. This lets you debug 
startup and initialization code. To illustrate this, you: 

o Enter Dynamic Run mode. 
o Set a breakpoint at the address of the Cdemon startup 

routine _start (a few instructions after the RESET vector 
fetch. 

o Issue a reset command to reset the CPU. If the emulator is 
plugged into an Applied Microsystems demonstrator board, 
you can use the demonstrator board RESET button to reset 
the CPU. 

This same procedure also works for a full target power-up 
sequence; you can actually cycle target power and still hit a 
breakpoint. 

This example is written for the Applied Microsystems 
demonstrator board. If you are using your own target and code, 
you can modify the breakpoint address to the startup routine 
used in your code. 

>- To restart the Cdemon program and enter dynamic run 
mode: 

1. From the File menu, choose Restart: 

2. In the Enter Command box, enter: 

drun 

Observe the LED on the demonstrator board incrementing. 

>- To set an instruction breakpoint at _start: 

• In the Enter Command box, enter: 
bi _start 
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>- To run to the breakpoint: 

• In the Enter Command box, enter: 
reset 

-OR-

If the emulator is plugged into an Applied Microsystems 
demonstrator board, press then release the RESET button 
located on the edge of the demonstrator board. 

SuperTAP breaks emulation at the beginning of the startup 
procedure _start, shown in Figure 5. 

>- To clear the instruction breakpoint at _start: 

• In the Enter Command box, enter: 
clear 1 

°'(-"•'.t .. •.:.•.r,:.:.r1.r,:.u.: .. ~.t .. •.t.t.r.:..·.u.: .. ·.:.:.: .. ·.:.· .. •.·.·,u.:.•.• .. • .. • ... ·.·.:.:.:u.:.:.:.:u.:.:.: .. • .. -.·.:.:.:.:.:u .. ·.·······.:.:.:.:~.:.:.:.:.:.:.r.: .. ·.: .. ·.:.:.: .. ·.:.•.:.u.:.:.:.:.:.:.r.:.:.:.:.: .. •.:.:.:.·.: .. •.:.:.:.·.:.:.:.:.:.:u.:u.:.:.:,:,.•,.•.:.:.·.:n.u .. •.:.:.:.: .. ·u.:.:.:.uu .. ·.:n.:.:.:.u.r .. ·.: .. -.·.:.u,:,u.:u.·.:. 

I C•-:::: •• f8: •••• ::~:'· Hod•l•:~~: Fil•: ~ 
II ::::~::~ :::::::: !:~D r8,l,lxl ·-~---~-:~_1_1_: 
~ fffH1DJJ: 480l1f00 b start ;J, 
~ fff06108: OUOOOIH IHULD ! 

I ::::~~~ :::::::: ::::~: I I fffH114: HOUHOO IHULD @R 
~ fff08118: 00080800 IHULD ~!:~~ 
§ fffH11c: OUOOOOOO IHULD l• 

iEI.JffWJ%*$~!llr~YI!~~~-

; Code I![!] £J 

Figure 5 Breakpoint at START (Assembly Code window) 

Need help? Call Customer Support at 1-800.ASK-4AMC for assistance. 



Example 2 - Scope loops and peek/poke trace 
Built in scope loops, cyclic redundancy checks (CRC-16), and 
memory diagnostic programs save you from writing your own 
routines to test memory or to stimulate memory for use with 
other tools, such as an oscilloscope. When running a scope loop 
or memory diagnostic, the read and write cycles are captured 
in trace memory (peek/poke trace). This information can be 
used to diagnose malfunctioning target memory or VO. 

Diagnostics 2 through 7 are used to perform reads or writes of 
selected memory. 

>- To perform a continuous read 

1. In the Enter Command box, enter: 

diag 2,0xaOOOOOOO •• Oxa0000400 

2. From the toolbar, choose Stop to stop the test. 

Diagnostic numbers 0 and 1 perform simple and complex 
diagnostics on the selected memory. 

>- To perform a complex memory test 

1. In the Enter Command box, enter: 

diag O,OxaOOOOOOO •• Oxa0000400 

2. From the toolbar, choose Stop to stop the test. 

Use the ere command with a range argument to perform a 
CRC-16 of the specified range. The command will return a hex 
value for the CRC. 

>- To perform a cyclic redundancy check 

• In the Enter Command box, enter: 
ere OxOxaOOOOOOO •• Oxa0000400 
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Example 3 - Benefits of event system qualified trace 
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Quite often there will be only a few cycles of interest out of the 
millions of cycles executed in a real-time run of the code. There 
are two ways of dealing with this: 

1. Capturing, in real-time, a trace of only the cycles of interest. 
This is a qualified trace. 

2. Post-processing (filtering out unwanted cycles) a large and 
expensive trace RAM buffer full of all executed and pre-
f etched instructions. 

The first is by far a quicker and more accurate method than the 
second. With SuperTAP's four-level event system architecture 
and trace control actions, you can capture a qualified trace 
based on a complex set of conditions, including program events, 
target hardware events, and the CPU bus state. 

The example demonstrates this ability by capturing only the 
first 10 memory write cycles directed to the in-memory 
representation of the demonstrator board LEDs. 

> To restart the Cdemon program: 

• From the File menu, choose Restart. 

> To configure the trace system: 

1. From the Displays menu, choose Emulator Configuration. 

2. In the Emulator Configuration window, choose Trace. 

3. In the Trace configuration window, choose: 

Collection State at Run:Don't Accumulate at Run 

This keeps trace capture turned off unless enabled by the 
event system. 

4. In the Trace configuration window, choose: 

Clear Buffer at Run:Discard Current Contents 

This clears the trace buffer when the emulator enters run 
mode. 

Need help? Call Customer Support at 1·800-ASK-4AMC for assistance. 



5. In the Trace configuration window, choose: 

Collection Qualification:Bus Cycles 

This configures trace for bus qualified capture. 

6. In the Trace configuration window, choose Apply to accept 
the values, then close the window. 

>- To configure the event system: 

1. In the Emulator Config window, choose Event. 

2. In the Event configuration window, choose: 

Counter I 1: Initial ValueReset to Zero at Run 

This resets the counter to zero when entering run mode. 

3. In the Event configuration window, choose Apply to accept 
the values, then close the window. 

4. In the Enter Command box, enter: 

when addr==cled_port cc status==wr then trone, ctrlinc 

Note: led_port is the symbol for in-memory representation of 
the LEDs (Ox80000000). The & tells the event system to look 
at the address of led_port. 

5. In the Enter Command box, enter: 

when ctr1==10 then break 

>- To run the target code: 

• From the toolbar, choose Go. 

SuperTAP breaks emulation after tracing the first 10 writes 
to the in-memory representation of the demonstrator board 
LEDs. 

>- To display trace: 

• From the Displays menu, choose Emulator Trace. 

Only the 10 write cycles are in trace, shown in Figure 6. 
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Fra1111e Address Data 

>- To clear the event system: 

• In the Enter Command box, enter: 
whenc:lr all 
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Figure 6 Emulator Trace window ·qualified trace capture of the first 1 O writes 
to the demonstrator board LEDs 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 4 - Isolate complex bugs with the event system 
Sometimes running to a basic breakpoint and examining trace 
history does not provide information specific enough to debug 
your target's code or hardware. You may also want the 
emulator to perform some action other than stopping code 
execution when the conditions become true. You may need to 
trigger an oscilloscope after a complex set of CPU bus cycle 
conditions become true; for example, the fifth write that a 
specific subroutine makes to a certain memory location. At 
other times you may want to trace only specific types of bus 
cycle information under certain conditions. 

The event system supplies the mechanism to define conditions 
and take actions. This mechanism allows the emulator to 
perform various actions based on conditions of complexity far 
surpassing that of simple breakpoints. 

The event system is used primarily for debugging nested or 
sequential problems. By defining a logical sequence of events, 
you can locate a hard to find bug that may exist only under a 
particular set of circumstances. 

The event system is implemented with emulator hardware and 
can be used in both RAM and ROM regions. 

Monitor complex sets of conditions 
SuperTAP event system comparators comprise 80 bits of 
information, including address, data, status, and external 
signals. The comparators can use "don't-care" masks and can 
cover ranges. Using these comparators, you can monitor a 
complex set of conditions, including program events, target 
hardware events, and the CPU bus state. 

Do more than just break 
When the event system conditions have been met, SuperTAP 
can perform a variety of actions including: 

o Break emulation asynchronously or synchronously 
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a Trace one or many CPU bus cycles 
a Set/increment/reset memory or register 
a Set or reset event system flags 
a Switch between event system groups 
a Enable or disable timestamp 
a Call a user specified function 
a Generate a trigger output to an external instrument 

The example is a simple case requiring more than a breakpoint. 
You set up the event system so that only the cycles within a 
certain function outled() are traced. To do this, you define two 
events to start trace capture when outled() is entered, and 
stops trace capture when outled() transfers program execution. 

:>- To restart the Cdemon program: 

• From the File menu, choose Restart. 

:>- To set up initial trace conditions: 

1. From the Displays menu, choose Emulator Configuration. 

2. In the Emulator Configuration window, choose Trace. 

3. In the Trace configuration window, choose: 

Collection State at Run:Don't Accumulate at Run 

This keeps trace capture turned off unless enabled by the 
event system. 

4. In the Trace configuration window, choose: 

Clear Buffer at Run:Discard current Contents 

This clears the trace buffer when the emulator enters run 
mode. 

5. In the Trace configuration window, choose: 

Collection Qualification:Cycles needed for Disassembly 

This configures trace to capture information for disassem­
bly. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



6. In the Trace configuration window, choose Apply to accept 
the values, then minimize the window. 

>- To set up event statements to start and stop tracing: 

1. In the Enter Command box, enter: 

ps outled 

From the output of the printsymbols (ps) command, you 
can easily determine the address range of the function out­
led(). 

: M\llXST860(tomb2) - Command !liJ £3 

Figure 7 Printsymbols output for outled() 

2. In the Enter Command box, enter: 

when addr==outled then tron 

This event statement turns tracing on at the start address of 
the function outled(). Notice a View window is opened when 
you enter the command. 

3. In the Enter Command box of the Command window, enter: 

when addr==Oxfff024cc then troff,break. 

This turns tracing off at the end of the function outled(), then 
breaks emulation. (Note: In this case the troff is not really 
necessary since trace capture always stops when a break oc­
curs. Troff is most useful when you want to capture a trace 
of something while continuing to emulate.) 

>- To run until the break condition is met: 

• From the toolbar, choose Go. 
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>- To view trace in the Emulator Trace window: 

1. From the Displays menu, choose Emulator Trace. 

This opens the Emulator Trace window with the default dis­
play mode (Raw Display) active. 

2. In the Display Format box, select the Assembly and Source 
checkboxes. 

Only the source lines and their associated assembly code for 
the function outled() are displayed in the trace buffer win­
dow, shown in Figure 8. 

>- To clear the event system: 

• In the Enter Command box, enter: 
whenc:lr all 
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Figure 8 Emulator Trace window - Trace of outled() 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Accelerate firmware development using overlay memory 

Description 

Real-time code execution vehicle 
Overlay provides stable substitute memory into which you can 
load your code and data. Using overlay, you can begin 
debugging your code before target memory hardware is 
operational. Overlay memory accelerates the code debug, re­
make, and test cycle. Using the high-speed net connection (5 
MB/sec) you can quickly download your fixed code into overlay 
rather than burn a new EEPROM. 

SuperTAP can be equipped with an optional 1 MB, 2 MB, or 4 
MB of overlay memory (zero wait states to 25 MHz, 1 wait state 
to40 MHz). 

Overlay memory can be allocated in minimum 128Kb segments 
(a 128Kb granularity). Overlay supports 8, 16, or 32 bit ports 
and DMA accesses by external bus masters. 

Copy memory contents between the target and overlay 
SuperTAP lets you easily copy the contents of target memory 
into overlay memory or from overlay into target memory. You 
can use this capability when you need to copy the contents of 
your target ROM (or PROM) into overlay memory, to avoid 
burning a new ROM. Also, copying the contents of target ROM 
into overlay lets you set software breakpoints within ROM 
memory space. 
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Example 5 - Using overlay memory 
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To use overlay memory you assign (map) it to address ranges 
and access types (read/write or read-only). Overlay memory 
can replace target memory or substitute for memory that does 
not exist in the target. 

In this example you view the overlay memory map set up by the 
cdemon.inc include file. 

> To view the current overlay memory map: 

1. In the Enter Command box of the Command window, enter: 

map 

Observe the current overlay map, shown in Figure 9. All 
three ranges of mapped overlay were assigned Read/Write 
access and there is 256Kb of overlay still available for map­
ping. 

2. Close or minimize the View Memory Map window. 

R.ange 
80000000 .. 8001FFFF 
AOOOOOOO .. A001FFFF 
FFFOOOOO •• FFF7FFFF 

AUAILABLE: 3328K of 

Figure 9 Overlay memory mapped by cdemon.inc include file 

Need help? Call Customer Support at 1·800-ASK-4AMC for assistance. 



Controlling code execution 

Description 

ControHing code execution 

When debugging code, the ability to control code execution is 
essential. SuperTAPs breakpoints and event system let you: 

CJ Stop asynchronously at any time 
!J Execute code until reaching a particular location or 

satisfying a set of conditions 
CJ Single step lines of source or assembly code 
CJ Step into or over function calls 

To provide this ability SuperTAP supports four types of 
breakpoints: 

!J Asynchronous 
CJ Hardware execution and access 
CJ Software execution 
CJ External 

Do more than just break 
When breakpoint conditions are met, SuperTAP can perform 
any of the following actions: 

CJ Stop emulation (break) 
CJ Execute a C expression 
CJ Log the value of an expression in a file 
a Execute a debugger macro 

Asynchronous breaking capability lets you stop code 
execution at any time by clicking the MWX-ICE Stop button. 
This ability can help in situations where you need to stop a 
program that is executing incorrectly and has bypassed a 
breakpoint you set. 
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Hardware execution and access breakpoints use the 
SuperTAP's hardware and do not consume any target 
resources. When a memory access occurs that matches the 
breakpoint condition, microprocessor execution stops. 
Hardware execution and access breakpoints can be set over 
target RAM or ROM. 

Software breakpoints replace the instructions in the target 
program with a special opcode that forces a specific behavior in 
the microprocessor. When the breakpoint occurs, SuperTAP 
halts execution and places the original instruction back into 
memory. 

External breakpoints allow an external trigger-in signal 
from the target or from a piece of test equipment, such as a 
logic analyzer, to cause the SuperTAP to "break" out of 
emulation. Or, the SuperTAP can generate a trigger-out signal 
to trigger a logic analyzer or storage scope. 

SuperTAP provides one BNC trigger input and one BNC 
trigger output pin to support both types of external 
breakpoints. 

Need help? Call Customer Support at 1-800-ASK·4AMC for assistance. 



Example 6- Intuitive breakpoints on code and data 

Controlling code execution 

Software breakpoints must be located in RAM, so that the 
special opcode may be written to target memory. This poses no 
problem, since SuperTAPs overlay memory can easily be used 
for setting breakpoints where no target RAM exists. 

MWX-ICE offers a variety of methods that make setting and 
clearing breakpoints easy. In this example, you sample the 
various methods including: 

o Using the Execution Control notebook 
o Choosing the Break! button with a source line selected 
o Dragging the Break! button to a source line 
o Using the Breakpoints window 

>- To restart the Cdemon program: 

• From the File menu, choose Restart. 

>- To set a permanent breakpoint using a notebook: 

1. From the Notebooks menu, choose Execution Control. 

2. From the Execution Control menu, choose Set and clear 
breakpoints. 

3. In the Break page Start Address box, type: 

main 

4. Choose the Set Break button, to set the breakpoint. 

Notice that "Breaklnstruction main" is echoed in the Com­
mand window. By observing and remembering the com­
mands generated while using notebooks and buttons, you 
can quickly start using the command line interface. 
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5. From the toolbar, choose the Go button to run to the 
break.point. 

Notice that the Code window box indicating the current exe­
cution line has moved to the beginning of main(). Also notice 
the break.point icon (a small stop sign) in the left side of the 
current execution line, shown in Figure 10. 

6. In the Execution Control notebook, choose Close to close the 
window. 

~ , MWXST860[tomb2) - Code --------------------!l-~-£1 

Co~rnand MPC860 Module: CDEHOH File: cdernon.cc i• 

52 ** Hain C Routine ~ 
s3 ***********************************************************"I~.*~ 
Sh ~~ 

... .>_f.Ja 

55 int ':j~ 
~: g;'in(int, char •[]) /• Prograo Starts lere •/ = 
59 if C uhich_derno ) ~ 
66 eleu_rnain(); ?!.@' 

61 I 
62 initial(); /* Initialize Uariables */ *B 
63 step(); /* Single Step Loop •/ ~ 
64 data(); /*Data Manipulation De~. Card Game*/~ 
65 run(); /*Run Blinking Leds */ &~ 
66 return U; W~ 

• 
• 
• 
• 
• 
! 

67 } F.;" 

1[]1lf;JJ;Jfil{®'Jlil4Z£lNJ1?~1:~1Jti!4fJ:®filftS§Jffif?RJ.~*il~~w~£;!~21~ 
Figure 10 Breakpoint at beginning of main() 

~ To set a permanent breakpoint using the Breakl button 
and a selected line: 

1. In the Source Code window, select the source line containing 
the step() function by double-clicking anywhere in that line. 

When selected, there will be at least one character of the line 
highlighted. 

Need help? Call Customer Support at H300-ASK-4AMC for assistance. 



Controlling code execution 

2. Choose the BreakI button l...!.J to set the breakpoint. 

Notice the breakpoint icon displayed to the left of the step() 
source line. 

3. From the toolbar, choose Go to run to the breakpoint. 

>- To set a permanent breakpoint dragging the BreakI 
button to a source line: 

1. In the Source Code window, click and hold the BreakI button 
and drag the breakpoint icon to the source line containing 
the data() function. 

Notice the breakpoint icon displayed to the left of the data() 
source line. 

2. From the toolbar, choose Go to run to the breakpoint. 

>- To run to a specific source line (temporary breakpoint): 

1. In the Source Code window, select the source line containing 
the run() function by double-clicking anywhere in that line. 

2. From the toolbar, choose the GoUntil button (man running 
to stop sign) to run to the run() function. 

>- To view permanent breakpoints: 

• From the Displays menu, choose Breakpoints. 

Notice the three breakpoints displayed in the window; the 
top one set at main() using the Execution Control notebook, 
the second one set at step() by choosing the BreakI button 
with a line selected, and the third set at data() by dragging 
the Break.I button. The Breakpoints window is shown in Fig­
ure 11. 
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Address 
! FFF02098 

• ! FFF02UB8 
• ! FFF020BC 

Type 
Instr 
Instr 
Instr 

sy111bol 
\CDEMOH\111ain\U57 
\CDEMOH\111ain\163 
\CDEMOH\rnain\164 

Co111Rand 
main 
\CDEMOH\163:4 
\CDEHOH\164:3 

Figure 11 Displaying infonnation about a breakpoint 

>- To clear all permanent breakpoints: 

1. In the Enter Command box of the Command window, enter: 

clear 

2. Close the Breakpoints window. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 7 - Hardware execution and access breakpoints 

Controlling code execution 

Hardware execution breakpoints use the SuperTAPs hardware 
and do not consume any target resources. Unlike software 
execution breakpoints, which must be set in RAM, hardware 
execution breakpoints can be set over RAM or ROM. Using 
either method, execution stops when the processor executes the 
instruction. 

Access breakpoints are useful for detecting errant accesses to 
memory locations. For example, you may want to break 
emulation if your code attempts to write over a constant 
pointer. 

In the example, you set a write access breakpoint (bw) at the 
memory address (&led_port is Ox80000000) of the in-memory 
representation of the demonstrator board LEDs. Read access 
(br) and read-or-write access (ba) breakpoints are set 
similarly. 

> To restart the Cdemon program: 

• From the File menu, choose Restart. 

> To set a write access breakpoint: 

1. In the Enter Command box, enter: 

bw &led_port 

2. From the toolbar, choose Go to run to the breakpoint. 

SuperTAP breaks emulation at the initialization routine's 
write to Ox8000000 (led_port's first address), shown in Fig­
ure 12. 

47 



48 

, Command fl!IOO ti! 
~> Restart 

1--~~~:-~~-~~~~~~~-~~~~~~~~-~~~~~-~~~~-to go to 111ain. 
p go 
~ Break I 1 on write to 80660600 •odule TEXT_2 (current instruction address = FFFIJllF-8)!• 

EIJf!ll&.!itWJ.~~~f.#if.41\l~~ilWJWl~Eil&~~f£¥M&W.18kft~f~l!§J.iWiffll.fE?iffe.l!~ffiffNJ • ~ 

Figure 12 Break on initialization (write} of led_port 

3. From the toolbar, choose Go to run to the breakpoint. 

SuperTAP breaks emulation in the outled() function at the 
write to the in-memory representation of the demonstrator 
board LEDs. 

> To monitor the variable led_port: 

L From the Displays menu, choose Data. 

2. In the Data window Expression field, enter: 

led_port 

3. From the Data window View menu, choose Show (char*) as 
String. 

4. From the toolbar, choose Go, to run to the breakpoint a few 
times while you watch the LEDs on the demonstrator board 
increment or the variable led_port increment in the Data 
window. 

5. Close the Data window. 

> To clear the write access breakpoint: 

• In the Enter Command box, enter: 
clear 1 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Capturing and viewing trace history 

Description 

Capturing and viewing trace history 

With trace history you can capture and record, in real-time, the 
execution history of the processor as SuperTAP executes the 
target program. Using trace history, you can verify the correct 
performance of the software and find errors that may occur in 
the program's execution. Trace lets you move from the 
environment of "hunt-and-peck" to one where real evidence is 
easily captured and displayed, helping you isolate and correct 
the bug. 

The intelligent trace disassembly feature - an industry first -
dramatically increases productivity by displaying instructions 
correlated with register values and bus cycles. 

Trace history offers 32K x128 bits of information including all 
active MPC860 signals and 32 bits of timestamp information. 
You can display raw bus cycles, full source-level, assembly­
level, or mixed source and assembly-level trace information 
with MWX-ICE's four trace display modes. 

Capturing "qualified" trace versus filtering continuous trace 
Quite often there will be only a few cycles of interest out of the 
millions of cycles executed in a real-time run of the code. There 
are two ways of dealing with this: 

1. Capturing, in real-time, a trace of only the cycles of interest. 
This is a qualified trace. 

2. Post-processing (filtering out unwanted cycles) a large and 
expensive trace RAM buffer full of all executed and pre­
fetched instructions. 

The first is by far a quicker and more accurate method than the 
second. 
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With a four-level event system architecture and "trace one 
cycle" action, SuperTAP lets you capture a qualified trace based 
on a complex set of conditions, including program events, 
target hardware events, and the CPU bus state. 

Execute and trace target power-up or reset sequences 
You can a execute a target power-up or reset sequence while 
collecting trace history, without hanging the debugger. With 
this you can more easily debug startup code. 

Dynamic trace display 
SuperTAP allows you to view and upload trace history without 
stopping or even pausing emulation. This means you can view 
your program's activity without disturbing its real-time 
operation. Example 9 in the Event System section of this guide 
demonstrates this ability. 

Tim est amp 
Timestamp information provides an accurate measurement of 
elapsed time between cycles displayed in trace. SuperTAP 
provides timestamp information to 40 nsec. 

Saving trace history in a file 
The log command lets you easily store trace history in a file by 
naming a Journal file in an MWX-ICE notebook then simply 
displaying trace. You can even log trace to a file without 
stopping emulation. 

After trace is saved, you can edit the file to add comments for 
future reference. For example, comments may be added to aid 
in documenting failure conditions. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 8 - Intelligent trace disassembly 
The "intelligent" trace disassembler boosts productivity by 
providing insight into the operation of the processor. The 
disassembler tracks the state of processor registers, letting you 
easily see how data is passed during code execution . 

._ To restart the Cdemon program: 

• From the File menu, choose Restart . 

._ To set up initial trace conditions: 

1. From the Displays menu, choose Emulator Configuration. 

2. In the Emulator Configuration window, choose Trace. 

3. In the Trace configuration window, choose: 

Collection State at Run:Begin Accumulating at Run 

4. In the Trace configuration window, choose: 

Clear Buffer at Run:Discard Current Contents 

This clears the trace buffer when the emulator enters run 
mode insuring that all cycles captured in trace are from the 
current code execution. 

5. In the Trace configuration window, choose Apply to accept 
the values, then minimize the window . 

._ To execute to the function step(): 

1. In the Code window, scroll down to the step() function. 

2. Select that line by double-clicking the function step(). 

3. From the toolbar, choose GoUntil. 

._ To view trace in the Emulator Trace window: 

Capturing and viewing trace history 

1. From the Displays menu, choose Emulator Trace. 

This opens the Emulator Trace window with the default dis­
play mode (Raw Display) active. Raw trace display includes 
address, data, active processor signals, and timestamp infor-
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mation. The Frame numbers provide an index of where the 
cycle occurred in execution history, the lowest Frame num­
ber being the most recent instruction executed. 

2. From the View menu, deselect Raw and select Assembly and 
Source. 

The source lines and their associated assembly code for pro­
gram execution to the function step() are displayed, shown in 
Figure 13. The Emulator Trace Action menu provides many 
useful trace utilities that let you easily: 

a Set breakpoints using trace information 
a Set the current scope based on trace frame 
a Search trace for any string patterns 
a Scroll through the trace buffer 
a Clear the trace buffer 
a Change trace display configuration 
a Change timestamp format and offset base frame 

Emulator Trace !ll.if EJ 
~ > for naskbit 1 i e i < 16 ~askbit << 1 • 
! 08032 fffU2458: 2c1d Gitt u CllllJlli r29, llx1 u ·%·· ! llUD31 ffHl245c: 4080 Oll4c bge .+Uxltc ip > FFFl245C ~ 
~ ip < FFFl2JUl8 ~ 
1>> led_port[i] • 'I'; /*finish with one last fraiw •/ tW 
j 110829 fff024a8: 3d811 8DUU addis r12,ll,lbcffff81UU :$J 
~ UUU28 fff024ac: 398c OllOD addi r12,r12,&lxU WJ. 
~011127 fffll24bll: 3960 11117c addi r11,&l,llx7c ~ 
! ll&IU26 fff&l24b4: 7d6c e9ae stbx r11,r12 ,r29 ~ 
~» } %.-
~ 11&11125 fffU24b8: bb61 UDUc 1- r27 ,Ux11Hc(r1) ~ 
~ llUD23 fffU24bc: 811U1 UD24 lia rO,llxUll211(r1) ~ 
~ UUU21 fffU24cO: 7cU8 03a6 •tspr lr ,ro :wi 
~ llOll19 fff024c4: 3821 0820 addi r1,r1,lbc20 fu~ 
! 00013 fff024c8: 4e80 0820 blr ip < FFF8211C t'"$. 
~-- >> } ~ 

w~ ~ 00011 fff0211c: 8Ultl Hile lia rll,UXUUOC(r1) $1 
! 00010 fff02120: 7cD8 U3a6 •tspr lr,ru !it 
~ 11&11108 fff&l2124: 3821 11808 addi r1 ,r1, Ux8 ;;,~ 
~ 001107 fff02128: 4e80 118211 blr ip < FFFU21188 ~ 
~ » step(); I• Single Step Loo~ •/ . ~ 
i-----------------------------------Execution Breakpoint---------------------------~ 
~---------------------------------------End of Trace-------------------------------~~ 
~ ,. 
~L!IJ.MJ~~fl$%WJ*~W~ift.Z!~~~~fJrt%•t¥&:~~4~J.rJ.?£$~~~i%~~~-~fffi~£$Jtb.l&W~~~·•· 

Figure 13 Emulator Trace window - mixed source and assembly trace 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 9 - Capturing and viewing trace while running 
In this example, SuperTAP emulates in dynamic mode; you can 
display trace while still emulating. You capture the run() 
function in trace using the event system, then view the trace in 
raw and disassembled formats. 

~ To restart the Cdemon program: 

• From the File menu, choose Restart. 

~ To set up the initial trace condition: 

1. From the Displays menu, choose Emulator Configuration. 

2. In the Emulator Configuration window, choose Trace. 

3. In the Trace configuration window, choose: 

Collection State at Run:Don't Accumulate at Run 

This keeps trace capture turned off unless enabled by the 
event system. 

4. In the Trace configuration window, choose: 

Clear Buffer at Run:Discard current Contents 

This clears the trace buffer when entering run mode. 

5. In the Trace configuration window, choose: 

Collection Qualification:Cycles needed for Disassembly 

This configures trace for bus qualified capture. 

6. In the Trace configuration window, choose Apply to accept 
the values, then minimize the window. 

~ To set up event system: 

1. In the Enter Command box, enter: 

when addr==outled then tron 
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2. In the Enter Command box, enter: 

when addr==Oxff f024c4 then troff 

The View Event System window should display the two 
event system statements. 

:> To enter dynamic run mode: 

• In the Enter Command box, enter: 
drun 

:> To display a "snapshot" of trace while still running 
target code: 

1. In the Enter Command box, enter: 

drt 

This displays trace history in raw format in the Command 
window. 

2. In the Enter Command box, enter: 

dtb 

This displays trace history in interleaved source and assem­
bly format in the Command window. 

Notice in Figure 14 that the register values on the right are 
matched to the source lines on the left. This is the "intelli­
gent" trace disassembly feature. 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



, Command 11!100 EJ 

>> led_port[i++] • (data 
11625 fffl248c: 3b6D 112a addi 
>> led_port[i++] = (data 
10624 fff82491: 3d8D 8801 addis 
11623 fff 12494: 398c 1111 addi 
11122 fffl2498: 7f6c e9ae stbx 
18121 fffU249c: 3bbd 1861 addi 

& 1'1i1Skbit) ? ' ' 
r27 ,O,Ux2a 

& maskbit) ? • • • •'; 
r12,0,0xffff81DO 
r12,r12,Bxl 
r27,r12,r29 
r29,r29,Bx1 

>> /* Build ascii chars in led port array From pattern •/ 
< 16; naskbit <<= 1) >> for (11askbit = 1, i = I ; i 

11119 fffU24al: 7fde f214 add 
11118 fffU24a4: 4bff ffb4 b 

r38,r31J,r31 
.-8x4c 

>> for (11askbit = 1, i I ; i < 16; 11askbit <<= 1) 
11116 ffU2458: 2c1d 1111 cmpwi r29, Ox1 o 
11015 fffl245c: 4180 114c bge .+Dx4c 

Figure 14 Dynamic trace display -disassembled source and assembly 

>- To exit dynamic run mode and clear the event system: 

1. In the Enter Command box, enter: 

dstop 

2. In the Enter Command box, enter: 

whanclr all 

This clears all event system statements. 
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Examples of other time-saving features 

Description 

56 

This section contains examples of other useful, time-saving 
features ofSuperTAPwith MWX-ICE: 

o Configure, understand, and debug peripheral registers 
o Displaying high-level data structures 
o Monitoring and modifying variables dynamically 
o Displaying and modifying memory 

Need help? Call Customer Support at 1-800-ASK-4AMC for assistance. 



Example 10 - Configuring/debugging peripheral registers 
MWX.-ICE includes the CPU Browser™ and Register Browser™ 
windows, to save you time you might otherwise spend 
referencing a technical manual for register bit meanings. The 
POR 0 PCMIA Option 0 window, is shown in Figure 15. 

> To browse the register: 

1. From the Displays menu, choose CPU Browser. 

2. From the CPU Browser Menu, choose PCMIA Interface. 

3. From the CPU Browser window, choose PORO PCMIA 
Option 0. 

PORO PC!ICIA Opeion O: l?~~~~~? .. ~?.~~~~~~-~-~~~~~~?~~--~~?.?.?.~~~~----·--·--_j 
G1) lrror-c:hec:k value on Apply 

PCllCIA Bmok Size: 11 Byt;~ 
PCllCIA Strobe Hole!. Tille: ,.{o_c_l_o_c:k_cy_c_i._EJ"'•"' 

PCllCIA Strobe Set_'llp Tiu: (1 cloc:k cycl• .. E 
PCllCIA Strobe Lengeb: [~~ .. =:?.~ .. =~:1:~;:8 
PCllCIA Port Size: 1...~ .. ~-~-~-~ ... S. 

r-----------i"~ PCllCIA Region Select: cmmon IU&Cl>:y space !• 
PCllCIA Slot Ic!.entifie 

Attribute .......,ry space 
Writ• Protected CReac!. I/0 space 

· DllA Cnoraal tr1111Sfer) 
PCllCIA Valid Bit: Inv DllA last tr1111Saction 

Figure 15 Browsing a register 
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Example 11 - Displaying high-level data structures 

58 

The MWX-ICE Inspector window lets you view complex high­
level data structures and quickly traverse linked lists. 

>- To restart the Cdemon program: 

• From the File menu, choose Restart. 

>- To run to house(), a function in data(): 

• In the Enter Command box, enter: 
g DATA\house 

Emulation breaks at the beginning of house(), a function 
within data(). At this point, all of the cards in the blackjack 
game have been dealt. 

>- To display the structure players: 

1. From the Displays menu, choose Inspector. 

2. In the Inspect Symbol or Expression box, enter the following: 

players 

The Inspector window displays a break down of players. You 
can scroll or resize the Inspecting window for the best dis­
play of the structure. 

3. From the Inspector window View menu, choose Show (char*) 
as String. 

4. From the Inspector window, choose S>> for player[01]. 

The Inspector window displays a break down of player[01], 
the second element of players. 

In Figure 16, you can see player1 "Warf' won, having been 
dealt 2 cards for a total of 21points. 

5. Close the Inspector window. 

Need help? CaU Customer Support at 1-800-ASK-4AMC for assistance. 



Figure 16 Displaying the structure players 
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Example 12 - Modifying variables dynamically 

60 

MWX-ICE provides windows for working with program 
variables. 

a Data window, for monitoring variables. 
a Inspector window, for viewing and modifying variables. 
a Register window, for viewing and modifying register-based 

variables. 

In static mode, they are updated only at each single-step, 
breakpoint, or program halt. In dynamic mode, emulation 
periodically pauses then re-starts, updating each window when 
emulation is re-entered. 

>- To restart the Cdemon program: 

• From the File menu, choose Restart. 

>- To enter dynamic run mode: 

• In the Enter Command box, enter: 
drun 

>- To dynamically monitor the variable led_port: 

1. From the Displays menu, choose Data. 

2. In the Data window Expression box, enter the following: 

led_port 

This places the variable led~ort in the Data window, shown 
in Figure 17. 

Need help? Call Customer Support at 1·800-ASK-4AMC for assistance. 



>- To enter dynamic update mode: 

• In the Enter Command box, enter: 
dupdate 1000 

This causes MWX.-ICE to continuously poll the emulator for 
the value of led_port. 

Observe the variable led_port in the Data window and the 
LEDs on the evaluation board incrementing. 

>- To exit dynamic update mode: 

• From the toolbar, choose Stop to exit dynamic update mode. 

, ~Data 1!!19 £1 
U1 led_port 
02 

" I *I I I I I I I I \x DD" 

03 
04 
05 
06 
07 
08 

Figure 17 Dynamic mode· Monitoring the variable /ed_portdynamically 

>- To dynamically modify the variable direct: 

1. From the Displays menu, choose Inspector. 

2. In the Inspect Symbol or Expression box, enter the following: 

Examples of other time-saving features 

direct 

The variable direct controls the direction of the demonstra­
tor LED's counting, either lefi or right. 
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3. In the Inspector window local menu, choose the long button 
to the left of the value lefi. 

This opens up a dialog box used to change the value of the 
inspected variable, shown in Figure 18. 

··-Tag Type HaRe Ualue CoMll!nt (if any) •.a. 

L ...... .J l.~~.".'.~~-!~~-~---· .. J l.d.~r~.!:~ .................................................................. l ............................................... . 

M\&IXS T8SO · Prompt Dialog £1 

!ro'· Ente1 new vale for 
(diect) I~ 

~I .~--,--f~-ca_nce1 __ --il 

~ . 
< 

Figure 18 Dynamic mode· Entering a variable's new value dynamically 

4. In the Enter new value field of the dialog box, type: 

right 

5. In the dialog box, choose Set to accept the new value. 

The Inspector window for direct should reflect the new value 
right, shown in Figure 19. Observe that the demonstrator 
LEDs are now decrementing. 

Need help? Call Customer Support at 1-SOO-ASK-4AMC for assistance. 



Figure 19 Dynamic mode • Modifying a variable dynamically 

~ To exit dynamic run mode and return to pause mode: 

1. In the Enter Command box, enter: 

dstop 

This forces SuperTAP from dynamic run mode back into 
pause mode. 

2. Close the Data and Inspector windows. 
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Example 13 - Displaying and modifying memory 
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MWX-ICE provides means for acting on a block of memory. 
Using either the command line or the Memory Commands 
notebook, you can clear, move, set, read, write, or log a block of 
memory. 

> To restart the Cdemon program: 

• From the File menu, choose Restart. 

> To display memory: 

1. From the Displays menu, choose Memory. 

2. In the Start Address box, enter: 

&led_port 

This displays a block of memory beginning with the address 
of led_port. 

3. From the View menu, choose Show ASCII. 

This displays the ASCII values for the corresponding mem­
ory data. 

> To manipulate a block of memory: 

• From the Notebooks menu, choose Memory Commands. 
The Memory Commands menu provides the following tools for 
working with memory: 

CJ Copy-eopy the contents of one block of memory to another. 
CJ Fill-fill memory with a given value. 
CJ Compare-eompare the contents of two memory blocks. 
CJ Search-search through memory for a pattern. 
CJ Examine stack-display values from a particular stack 

level. 

Need help? CaU Customer Support at 1-800·ASK-4AMC for assistance. 



Conclusion 

Conclusion 

Thank you for using the Applied Microsystems SuperTAP. 

Now that you have completed the demonstration of SuperTAP 
with MWX-ICE debugger, you can refer to the MWX-ICE User's 
Manual for more information about using the debugger. 

If this has been a SuperTAP pre-sales demonstration, please 
contact your local sales office for pricing and ordering 
information. 
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I AppencfxA 

Cdemon Demonstration Program 

Cdemon Demonstration Program 

Cdemon is the Applied Microsystems standard CIC++ 
demonstration program, providing examples of many code and 
data constructions used by programmers. An in-memory 

. representation of the LEDs (led~ort) may be used to see the 
output of some of the functions. 

Cdemon is composed of two discrete programs. The default C 
program writes to the LEDs and plays a simple band of 
blackjack. The other, a C++ program, simulates an elevator. A 
variable named which_demo determines which of the two 
demonstration programs is executed. The card game program 
runs by default. If which_demo is set to 1, then the elevator 
program is executed. 

A functional block of the LED-lighting/blackjack. game is shown 
in Figure 20. 

67 



initial{) 

step{) 

68 

START 

INITIAL 
Initialize data 

STEP 
Sim le control of the LED 

DATA 

RUN 
Scroll the 

Figure 20 Flowchart of Cdemon 

The function initial() initializes the three global LED-control 
variables, pattern, speed, and direct. These variables control 
the byte pattern, the speed, and the direction of LED pattern 
rotation, respectively. 

After initializing the global variables, initial() passes control to 
step(). 

The function step() performs five loops of a simple LED control 
process, and passes control to data(). 

Need help? Call Customer Support at 1·800-ASK-4AMC for assistance. 
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Cdemon Demonstration Program 

Step() declares the loop-control variable loops. In each of its five 
loops, step() calls outled() 17 times, each time passing outled() 
a one-byte argument which represents the pattern displayed 
on the demonstration board LEDs. 

Outled() then writes the pattern to the LEDs (pointed to by 
dot_port) and to an in-memory representation of the LEDs 
(symbolically named led_port). Each of the 17 arguments 
passed to outled() by each loop in step() represents one LED 
pattern. 

While the execution of step() can be observed with the trace 
function, the purpose of step() is to demonstrate, in a single­
stepped fashion, the relationship between the code and the 
LEDs. 

The most basic control of step() comes from single-stepping 
while observing and modifying the loop-control variable loops. 
Loops may be observed with the Data window, and observed or 
changed with the Inspector window. Setting loops to a high 
value will lengthen the time spent in step(), while setting loops 
to zero will very quickly cause program control to be passed to 
data(). 

Because step() produces a repeating cycle of data on the bus, 
predictable data-value conditions are available to the event 
system. 

The function data() plays a five-handed game of blackjack with 
four players and a dealer. When the game is won, data() passes 
control to run(). Data() requires no input and generates no 
output, and is simply a code environment with interesting data 
structures. 

The primary data structures are: 

1. card, a structure defining the value and suite of each card. 

2. player, a structure containing each player's name, a hand 
(array) of five cards, a point total, and a card count. 
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3. card_deck, a union with various array types describing the 
cards in the four suits, the cards in the two sub-decks for 
shuffling, and the cards in the shuffled deck. 

After the declarations, data() initializes player names and sets 
cards dealt and points for each player to zero, then executes the 
following functions. 

in it() 
This function initializes players and dealer structures. 

sort() 
This function sets up a 52-word block of memory as a deck of 
cards. 

shuffle() 
This function divides the deck into two 26-word blocks and 
interleaves them, simulating the shuffling process. 

deal() 
This function deals one card to each player, including the 
dealer. 

hit() 
This function deals cards to each player until points >= 18, or 
cards dealt= 5. 

house() 
This function deals cards to the dealer until points >= 17, or 
cards dealt = 5. 

The players each draw for cards while they have less than 21 
points and more than 18 points. The dealer uses a similar 
routine to draw cards until his hand contains more than 17 
points. The game concludes after one round. 

The data() function only executes once. To replay the game, 
reset the program to return to the beginning of the code, and 
run the code until it reaches a temporary breakpoint set at the 
beginning of the data() function. 

Need help? Call Customer SUpport at 1-800-ASK-4AMC for assistance. 
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Cdemon Demonstration Program 

The function run() writes a string from left to right (or right to 
left, depending on the value of the variable direct) to the LED's 
endlessly. Rather than using separate statements like step(), 
run() uses a ''while" control structure under the direction of the 
speed and direct variables from initial(). Program control stays 
with run(). 

Run() declares external functions outled() and wait(), declares 
the byte maskbit, the integer cputype, the loop-control variable 
i, and the constant forever = 1. 

outled() 
This function writes an 8-bit value to the LEDs (pointed to by 
dot_port) and to led_port, the in-memory representation of 
LEDs. 

wait() 
This function sets the actual delay according to the value of two 
arguments, cputype and speed. 

The mechanics ofrun() can be observed by changing the values 
of direct and speed, and then running without breakpoints. The 
effects of changed variables in the LED-control task can be 
observed directly at the LEDs or at the Data window while 
monitoring led_port. 
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